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BY USING THIS SOFTWARE YOU ACCEPT THIS LICENSE AGREEMENT.
IF YOU DO NOT AGREE TO THIS LICENSE AGREEMENT YOU MAY RETURN THIS PRODUCT.

Yamaha DMC1000 (STEREO) Project Manager
End User Software License Agreement

1. Software. Yamaha DMC1000 (STEREO) Project Manager is comprised of the computer programs and documentation contained
in this package and is referred to as the "Software”.

2. A “Yamaha” Product. The Software is a product owned and developed by Yamaha Corporation. (“Yamaha”)

3. Licensee. Licensee is the person or entity who gave this License or for whom this License was given.

4. License. Yamaha grants to Licensee a nonexclusive, nontransferable license (the “License”) to use the Software in
accordance with this Agreement on a single microcomputer.

5. Protection of Software. Except as expressly authorized in this Agreement, Licensee may not: (i) disassemble, decompile or
otherwise reverse engineer the Software, or (ii) create derivative works based upon the Software, or (iii) rent, lease,
sublicense, distribute, transfer, copy reproduce, modify or timeshare the Software, or (iv) allow any third party to access or
use the Software, or (v) modify the Software (including any deletion of code from or addition of code to the Software).

6.(a). DISCLAIMER OF WARRANTIES. YAMAHA MAKES NO WARRANTY, REPRESENTATION OR PROMISE NOT
EXPRESSLY SET FORTH IN THIS AGREEMENT. YAMAHA DISCIAIMS AND EXCLUDES ANY AND ALL IMPLIED

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE YAMAHA DOES NOT WARRANT
THAT THE SOFTWARE WILL SATISFY LICENSEE'S REQUIREMENTS OR THAT THE SOFTWARE IS WITHOUT DEFECT OR
ERROR OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED.

6.(b). LIMITATION ON LIABILITY. THE AGGREGATE LIABILITY OF YAMAHA ARISING FROM OR REIATING TO
THIS AGREEMENT OR THE SOFTWARE (REGARDLESS OF THE FORM OF ACTION OR CLAIM-LE.G., CONTRACT,
WARRANTY, TORT, COMPUTER MALPRACTICE, FRAUD AND/OR OTHERWISE) IS LIMITED TO THE TOTAL OF ALL
PAYMENTS MADE BY OR FOR LICENSEE TO PURCHASE THE LICENSE YAMAHA SHALL NOT IN ANY CASE BE LIABLE
FOR AND SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT OR PUNITIVE DAMAGES EVEN IF YAMAHA HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YAMATIA IS NOT RESPONSIBLE FOR LOST PROFITS OR REVENUE,
LOSS OF USE OF THE SOFTWARE, LOSS OF DATA, COSTS OF RE-CREATING LOST DATA, THE COST OF ANY SUBSTITUTE
EQUIPMENT OR PROGRAM, OR CILAIMS BY ANY PARTY OTHER THAN LICENSEE. THE OFFICERS, DIRECTORS,

EMPLOYEES, SHAREHOLDERS AND REPRESENTATIVES OF YAMAHA ARE NOT PARTIED TO THIS AGREEMENT AND
SHALL HAVE NO OBLIGATION OR LIABILITY RELATING TO THIS AGREEMENT OR THE SOFTWARE.




DMC1000 Project Manager V4.0 ST page 1

DMC1000 Project Manager

Note about this Manual: Throughout this manual, the symbol M> is used to
indicate information that is only relevant to users of multiple- -DMC1000
systems. Users of single-DMC1000 systems can ignore these sections.
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Introduction

The Project Manager software has been developed to allow control and editing
of the DMC1000's parameters from an Apple Macintosh computer, while also
offering the advantages of a larger display and easier access to information.

The following extensions to the DMC1000's capabilities and functions are also
provided:

o A comprehensive Effects Editor and Librarian.

. 4 Additional Fader Groups.

° 4 Additional Channel Parameter Links

° Project management, allowing all files relating to a specific project
to be managed and stored within the Macintosh’s disk drives.

. Integrated control of multiple-DMC1000 systems.

° Control of the DMC1000’s disk-drive from the Macintosh.

. Control of automation system ‘transport’ and editing functions.

. EQ Snapshot and Librarian facility.

. Graphic display of EQ curves.

. Channel Delay Editor and librarian tool with snapshot capabilities.
. Channel Page for control and display of all channel parameters.
. Error and Status Reporting displayed on the Macintosh monitor.

DMEMIO 00!
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Designed and Programmed by : Zack Settel
Project Manager : Terry Holton - Yamaha R&D Centre, London, LK

Additional Programming: Daniel Fowell
David Waxman
Basil Hilborn
Acknowledgements : IRCAM, Paris, France
‘Yamaha Corpaoration Japan
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System Requirements

1.1 Macintosh Requirements

For use with a single DMC1000, the Apple Macintosh computer
should be an LC III or higher model and should have at least 5 MB
of available RAM and Macintosh System 6.0.7 or higher. (Refer to
2.2 for further details about RAM requirements.) Certain aspects of
system performance will be related to the speed of the Macintosh
computer being used. For example, screen redrawing speed and data
transfer rates will vary according to the specifications of computer
system.

Approximately 4MB of hard disk space is also required.

Project Manager V4.0ST can be used with black and white, gray-
scale or color monitors. When gray-scale or color monitors are
used, select 256 greys or colors. Do not use 4 or 16 grays or colors.
Screen redrawing (particularly of EQ graphic displays) will normally
be much faster when using black and white mode.

For use with a multiple-DMC1000 system, an LC475 or higher model is
recommended, with at least SMB of available RAM and Macintosh
System 06.0.7 or higher.

T2 MIDI Hardware Requirements

For use with a single DMC1000 with no additional MIDI devices, a
standard Macintosh/MIDI interface (such as the Opcode MIDI
Translator) is recommended. Two MIDI cables will also be required.

For use with two DMC1000s, a pair of standard Macintosh/MIDI
interfaces is recommended, with each interface connected to a
different serial port of the Macintosh (ie. Modem and Printer). Two
MIDI cables per DMC1000 are required.

For use with three or more DMC1000s, the Opcode Studio 5 is the
onlvy recommended interface. Two MIDI cables per DMC1000 are
required.

For maximum data transfer reliability, the Studio 5 -> Macintosh
speed could be set to 1.2 X MIDI.

For the Macintosh -> Studio 5 communication speed, a setting of 2 X
MIDI is recommended.

1.3 Software Requirements

Project Manager V4.05T is a standalone application which has been
created using the Opcode MAX graphic programming environment.

Project Manager V4.0ST must be used with Yamaha DMC1000
system software 52.10 or higher (52.16 or higher recommended).

For multiple-DMC1000 systems, OMS V1.2 (or higher) software is also
required. Refer to 2.5 for details.
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Installation Guide

2.1 DMC1000 Project Manager V4.0ST Installation
(1) Insert the DMC1000 Project Manager V4 disk into the Mac’s floppy-
disk drive.
(3) Double-click on Project Manager V4.0ST - 1.sea (the 1 indicates that
this version is for use with a single DMC1000).

M>  Users of multiple-DMC1000 systems should install a Project Manager
version which has been designed to control the total number of
DMC1000s in your system.

(4)  Open a suitable folder on your Mac’s hard-disk drive.
(5)  Click on Extract. This will cause the Project Manager program and
related files to be decompressed and saved onto your hard disk.

2.2 Memory Allocation

Before beginning to use Project Manager, the application must be allocated
sufficient memory. The main Project Manager V4.05T program requires a
recommended minimum of 5000K of RAM, and additional memory must be
allocated if any of the DMC Tools are to be used. Additional memory allocation
requirements for the DMC Tools are approximately as follows (the first number
indicates the amount of memory which must be available to allow the tool to
open; the second number indicates the actual amount of memory the tool will
occupy once it has opened):

*EQ Snapshots V4.0 ST requires an additional 2700K / 2300K
*EQ Overviews V4.0 ST requires 2000K / 1520K

*Channel Page V4.0 ST requires 3850K / 3050K

*Delay Editor V4.0 ST requires 1200K / 850K

*Faders & Cuts V4.0 ST requires 550K / 400K

* Cascade Pad Editor V4.0 ST requires 90K

* Automation Browser V4.0 ST requires 40K

Note: The memory allocations listed above may be slightly higher than are
actually required when multiple DMC Tools are being used simultaneously.

Use the following procedure to allocate memory for Project Manager:

(1) Click once on the Project Manager V4.0ST program icon. Then
select Get Info from the File menu (<Command I>).

The Info window will appear:

~Memory Requirements ...
i Suggested size: 12000 K i

Minimum =size: |S000D K

DLocked FPreferred size: |12000 |K

..............................................................................
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(2)  Change the Application Memory Size according to your anticipated
requirements.
3) Close the Info window.

Note: Memory requirements may vary slightly from one computer to another.
If Project Manager fails to launch properly, adjust the Application Memory Size
and relaunch the program.

2.3 Connecting the DMC1000 to the Macintosh Computer
A Macintosh/MIDI interface is required to allow data communications between
the DMC1000 and the computer.

Example 1 - a basic setup containing one DMC1000, a Macintosh computer and
an external effects device:

1) Connect the MIDI interface to one of the serial ports (the Modem
port is recommended) on the Macintosh. A simple interface like
the Opcode MIDI Translator is ideal for this configuration.

(2) Connect the MIDI Out of the DMC1000 to the MIDI In of the
interface.

3) Connect one MIDI Out of the interface to the MIDI In of the
DMC1000.

(4) Connect another MIDI Out of the interface to the MIDI In of the
external effects device. External effects devices should be set to
receive program changes in Omni mode.

M> Example 2 - a system consisting of two DMC1000s, external effects devices, and
a Macintosh computer:

(1) Connect a MIDI interface to each of the Macintosh’s serial ports
(Printer and Modem).

(2)  Use the Modem port for DMC1000 number 1 and the Printer port for
DMC1000 number 2. Connect the MIDI Quts of the DMC1000s to the
MIDI Ins of the interfaces.

(3)  Connect the interfaces’ MIDI Outs to the MIDI Ins of the DMC1000s.

(4) Connect any external effects devices to the MIDI Outs of the interface
which is connected to the Mac’s Modem port.

M> Example 3 - a system consisting of three or more DMC1000s, external effects
devices and a Macintosh computer:

(1] Connect an Opcode Studio 5 interface to each of the Macintosh’s
serial ports (Printer and Modem).

(2) Connect the MIDI Out of DMC1000 number 1 to MIDI In port 1 of the
interface. Connect DMC1000 No. 2 to port 2, DMC1000 3 to port 3, etc.

(3) Connect the MIDI Out from the interface’s port 1 to the MIDI In of
DMC1000 No. 1, port 2 to DMC1000 2, etc.

(4)  Connect MIDI out ports 7 to 15 of the Studio 5 to external effects
devices for the purpose of receiving MIDI program changes.



DMC1000 Project Manager V4.0 ST page 13

2.4 Installing System Software in the Yamaha DMC1000

In order to use Project Manager V4.0ST software, the DMC1000 must have S2.10
system software (or later) installed.

To change the DMC1000’s system software, use the following procedure:

(1)  Back-up the following data to a floppy disk:
e Internal Memory
e Set-up Memory
(2)  Boot the system software using either Method A or B.

Method A

(1) Turn off the power to the DMC1000.

(i) Insert the Yamaha DMC1000 system software disk into the
DMC1000's internal disk drive.

(iii) Turn on the power to the DMC1000 and the system software will
automatically be loaded from the floppy disk.

or Method B

(1) Insert the Yamaha DMC1000 system software disk into the
DMC1000's internal disk drive.

(ii)  Use the LCD Control section on the DMC1000 to open the Boot page.

(iii) Using the Parameter Select keys, move the cursor to [Execute].

(iv) Press the Parameter Adjust [+1/ON] key. An Are You Sure? prompt
will appear in the LCD. Press [+1/ON] again and the System
Software will be loaded from the floppy disk.

(3)  Go to the Sys.Init page and perform a System Initialization.
(4) Re-load the DMC1000 data (Internal Memory and Set-up Memory
Data) from the back-up floppy disk.

2.5 Installing OMS
Before beginning to use DMC1000 Project Manager, the Opcode MIDI System
(OMS) should be installed in the Macintosh. OMS V1.2 or higher is required.
If OMS is already installed on your Macintosh, there is no need to re-install it.

OMS Installation instructions:

(1) Insert the OMS disk into the Macintosh and double-click on OMS
1.2.3 installer.

Note: If the Macintosh crashes while installing OMS, remove any virus-
checking extensions from the System folder, restart the Mac, and run the
Installer again.

(2) The Welcome to the OMS Installer dialog box will appear.
Click Continue.
3) The next screen contains basic installation instructions for OMS.
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After reading these instructions, click Continue.

(4) A dialog box will appear asking whether you have an Opcode Studio
4 or 5 in your system. Click YES or NO accordingly.

(5)  In the next screen, click Install to install OMS on your Mac’s hard
disk.

(6)  After installation has been completed, a dialog box will appear
instructing you to restart your Macintosh in order for OMS to be
activated. Click Restart.

OMS installation is now complete.

2.5.1 Selecting an OMS File

Inside the DMC1000 Project Manager folder, a folder named OMS Files can be
found. Open this folder and double-click on the appropriate file to suit your
DMC1000 configuration. For example, the file STD Interfaces - 2 DMCs is for
use in a system consisting of 2 standard interfaces (ie. Opcode MIDI Translators)
and 2 DMC1000s. An external effects device (receiving program changes) could
also be included in this configuration.

After opening an appropriate OMS file, execute the following procedures:

{13 From the File menu, select Make Current.

{2} From the Studio menu, select Interfaces. This allows OMS to check
the interfaces that are connected to the Macintosh. Click Update
Setup.

3) If you have interfaces connected to both of the Mac’s serial ports,
make sure Modem and Printer are both checked. Then click Search.

Serial ports to search for MIDI interfaces:

] Modem
(< Printer

Make sure your MID| interfacels) are connected, powered on, and
have any MID1/Thru switches set to MIDI.

Uncheck ports which are attached to dewices ather than MIDI
interfaces. Grayed ports are unavailable. If you do not uncheck a port
to which some other device is attached, the search for interfaces may
hang. If this happens, disconnect the non-MID| serial device.

[ Cancel | Ir Seﬁrll

(3) From the Studio menu, select Test Studio. With MIDI Control Tx
turned On in each DMC1000, you will be able to verify the interface
connections by simply moving any controls (faders, etc.) on the
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DMC1000s. A voice in the Macintosh will confirm that MIDI is
being received. Test each DMC1000 in the system, then turn Test
Studio Off.

4) From the Edit menu, select OMS MIDISetup. Under Compatibility,
select Only OMS Applications. Then click OK.

(5)  From the File menu, select Quit. A dialog box will ask if you wish

to save changes which have been made to the OMS Setup
document. Click Save.

2.5.2 MIDI Communications Problems

If communications problems occur after Project Manager has been launched,
select MIDI Setup from the File menu. The following diagram shows the
correct setup for a 2-DMC1000 system with an external effects device also
connected to the first interface (Modem Port). In the ID column, DMC1000 1
should be identified as a, DMC1000_2 as b, etc..

MIDI Setup
Input Devices ID Chan Output Devices ID Chan
Mame (a-z) Offset Mame (a-z) Offset
DMC1000_1 a 0 K¥ [DMC1000_1 a 0 Ky
DME 18002 b 0 DMC1000_2 b 0
EFFELTS a 0
Iy

Not Using MIDI Manager

[ ok ]| [cancel | [ AutoSetup ] [ 0Ms MIDI Setup... |

Note: Provided your DMC1000 configuration does not change, it should only

be necessary to execute the procedures in section 2.5 the first time you setup
your Project Manager system.

2.5.3 Testing MIDI Connections .

MIDI connections between the DMC1000 and the Macintosh can be tested by
selecting MIDITest from Project Manager in the menu bar. The I/O test will be
executed as the I/O Test window opens. The test can be repeated by clicking on
Test Again. In multiple-DMC1000 systems, use Display/Edit to select the
DMC1000 to be tested.
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2.6 Launching DMC1000 Project Manager V4.0ST

ey
(2)

Before launching Project Manager, power-up the DMC1000.

Open the DMC1000 Project Manager folder and double-click on
the Project Manager V4.0ST icon to launch the application. (This
icon will have a different appearance in Macintosh System 6.)

Project Manager VY4.0 - 1

(3)  When DMC1000 Project Manager is first launched, certain
parameters in the DMC1000 are initialized and an I/O test is
conducted. After the DMCMain page appears, all data from Scene
Memories 1-32 will be loaded from each DMC1000 into the
Macintosh. At the beginning of this process, Scene Memory 0 will
be recalled in each DMC1000. When the process is completed, Scene
Memory 1 will be recalled. (If it is not necessary to upload all of the
first 32 Scene Memories into Project Manager, click on Abort after
Project Manager has started receiving Scene Memories.)

The following will be displayed for a few seconds when Project Manager has
completed initialization and is ready for use:

DMC 1000 Project Bulk/Scene

Status: |DMC Initilized and ready
Error: i

Data ltems
Scenes: General: Automation:

>06

Manager Receive
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Using Project Manager

Warning: Do not use the Overdrive option while Project Manager is being used.
Also, AppleTalk should not be active.

3.1 Start-Up Defaults

As Project Manager is launched (refer to 2.6 for procedure), certain parameters
on the DMC1000 are automatically set. (Refer to Appendix A).

The current Setup state of the DMC1000, the current Edit buffer (containing all
mixing console parameters), and Scene Memories 1-32 will automatically be
loaded from the DMC1000 to Project Manager during the start-up process. (See
Appendix B for details about which parameters are contained in Setup Data).

Project Manager is designed to be used with the initialized Control Change and
Program Change assignments. If either of these assignment tables has been
altered, Project Manager may not function properly. If the Installation
procedure (described in section 2) has been followed, the DMC1000 should
contain the initialized assignment tables for use with Project Manager. These
default files are also located in the User Files folder. If necessary, these files can
be loaded into the DMC1000 using the Open Bulk procedure in the Project page
(refer to 5.6.9 for details).

3.2 Selecting and Editing Parameters
There are several different ways of selecting and editing parameters within the
Project Manager application.

a) Changing a parameter by marking or removing an X from a box:

CO/DAT Dut
>l Copy Prohibit

E;I Noise Shaping

Point the tip of the cursor arrow at the box and click.

b) Pop-up (Pull-down) menus:

3 dutomation
Relative N ] Fader Edit mode
Absolute
Autornation
L Record Mode
Point at the menu item, then click and hold with the mouse button. Drag the
mouse up or down until it is pointing at the appropriate selection, then release
the button. If you simply want to view the menu choices without making a

selection; move the mouse outside of the menu box before releasing. Some
pop-up menus may contain 30 or more possible selections.
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()] Number Boxes:
ER/Rev Bal

pso |%

Boxes which contain triangles on the left side allow numerical values to be
directly entered from the Mac keyboard. Click on the box first to highlight the
triangle (with black and white monitor systems, the triangle will appear dark -
however, with gray-scale systems the triangle with appear lighter when
selected; on color monitors, the triangle will turn yellow). Then type in a value
from the Mac and press <Enter>, <Return>, or click outside the box. Values in
Number Boxes can also be changed by dragging the mouse up or down, or (in
the case of many number boxes) by using the up and down arrows on the Mac
keyboard.

In some windows (such as EQ Snapshots), there are boxes which do not allow
values to be entered directly from the Mac’s numeric keys, but do allow values
to be scrolled.

d) On-screen sliders:

Reverb
Time

Eé

|2.9 ISEC

In the example shown above, point the cursor arrow at the on-screen slider and
while pressing the button, drag the mouse up or down. In this particular
example, clicking on the number itself will reveal a pop-up menu from which
an exact value can be selected.

e) Buttons:

set last touched parameter to Extract

Clicking a button will execute a command in the DMC1000 or open another
window in Project Manager.
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3.3 Macintosh Keyboard Commands

Keyboard commands can also be used to execute certain procedures or to access
Project Manager windows:

C = open Channel Page main window
D = open Delay Editor main window

E = open EQ Overviews main window
F = open Faders and Cuts main window
S = open EQ Snapshots main window

M = Menu selection only for Channel Page and EQ Snapshots
T = Touch channel-select for Channel Page and EQ Snapshots

[ = Display Left channels in the EQ Overview tool
| = Display Right channels in the EQ Overview tool

Shift D = open Disk Manager

CTRL A = Automation Undo
CIRL U = Undo latest Scene Memory Store or Recall

CTRL K = Keep Touch On mode
CTRL N = Normal Touch mode

Command M = Open Status window

Escape = update Project Manager displays
Double-click Escape = request Setup and Scene edit buffer data from the
DMC1000

M> Extended Kevboards Only
F5 = Display DMC no.
F6 = Display DMC no.
F7 = Display DMC no.
F8 = Display DMC no.
F9 = Display DMC no. &
F10 = Display DMC no. 6

N =

U1

F11 = Edit Display DMC only
F12 = Edit All DMC1000s

Transport Commands

The following Transport Commands will affect the automation systems in all
DMC1000s linked in the system. These commands will only function if
transport command keys on is selected (refer to 12.5.3).

Enter = Automation Record
Spacebar = Automation Play
Return = Automation Stop
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M>3.4 Display/Edit

The Display/Edit window can be brought to the top level by selecting Show
Display/Edit in the Project Manager menu.

I

[EC0== [DISPLAY_EDIT]

[

display :

HUTTLS AT

edit g“z F 4 5 6

| 95 I (received scene)

G B

I <]

Project Manager V4.0ST allows control of up to 6 DMC1000s simultaneously. The
display of parameter settings and values on the Macintosh monitor relates to
only a single DMC1000 at any given time. The Display/Edit window indicates
which DMC1000 is currently represented in the Project Manager display
windows. This is indicated by a red “LED” in the display row.

Although only one DMC1000 has its parameters displayed at any given time,
parameter changes can be sent to more than one DMC1000 simultaneously. If a
DMC1000 is selected in the edit row, any parameter changes made in Project
Manager will be sent to that console. Click in any box 1-6 to select a DMC1000 to
receive parameter changes. The display DMC1000 will always be selected to
receive edits. Clicking on the word edit will toggle between a single DMC1000
selected and all DMC1000s selected to receive edits.

On extended keyboards, functions keys F5-F10 can be used to select DMC1000s 1-6
as the display console. F11 can be used to select only the display console to
receive edits and F12 is used to select all DMC1000s to receive edits. Also, the SEL
keys on the DMC1000 control surfaces can be used to select the console for
display by double-clicking (refer to 4.3.3).

The received scene box in the lower left corner will display the currently
received scene number as they are being sent to Project Manager.

Note: This window cannot be closed. If it is not needed, hide it behind the *DMC
Main window.
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- DMC1000 Project Manager - Main Page

This is the main window which appears on screen as the Project Manager
application is launched.

% File Edit Windows Project Manager Project Pages

[*DMC Main]

DMIGILOOY Preyjest Manawer v4.0

effects mac
project control digital edit/lib gqroups config
Wy 36 = AES/EBU eopen yes
E:”E""‘ & SDIF esave 110
——®open Ej] ﬁ'@ CD/DAT wedit sdisgble
—esave 10101010 estore +enable
2 ? ? 2 2 2
i midi & audio b mac auto
display® timecode setup automation |jnks transport
24 25 30 mon. / :-D- Tz o5 4
cTL®] input ! N [H?EIIJD
pl"E COQI;]
103:3321 eon/off extract l;-]a-— E-;g
2 ? 2 ? 2 7

When DMC1000 Project Manager is first Jaunched, certain parameters in the
DMC1000 are initialized and an I/O test is conducted. After the DMC Main
window appears, the current Edit buffer, the Setup state, and Scene Memories
1-32 will be loaded from each DMC1000 into the Macintosh. The progress of the
Scene Memory data transfer can be monitored in the Project Manager Status
Display window. Scene Memory 0 will be recalled in each DMC1000 at the
beginning of this process and Memory 1 will be recalled when this process is
complete. Project Manager is then ready for use.

4.1 Project Manager Program Structure
Project Manager V4.0ST is structured such that certain essential elements are
opened during the initial launch of the main program. These items are
contained in various pages which can be accessed by clicking on the icons
displayed in the DMC Main window shown above. These pages can also be
opened by selecting them from the Project Pages menu at the top of the screen.

Other useful utilities are contained in the DMC Tools folder, and can be opened
individually by the user when required. Refer to Section 18 for details about
DMC Tools.
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4.2 Help?
Information about the parameters contained in each page can be displayed by
pointing at the ? under the page's icon. Click and hold the mouse button to
reveal a list of items contained in that page. Releasing the mouse button when
any of these items is highlighted will cause the appropriate page to open.

mac auto
links tramnsport

e P A

QEIE

Transport Controls
Record/Play Tracks
Automation Sync

MIDI Remote

dutornation Locate Made
Fader Edit Mode
dutornation Record Mode
Fader Motors
Automation Undo

Master Section Controls
Monitor Mode Stereo/Mono
Dimmer Control

A1l Selos Off

Meter Hold
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4.3 Options

Several user-definable options are available.
Manager in the menu-bar.

Select Options from Project

|

= [[PMS Options]] =05
» Error/Status Reporting afs

mspﬂag Errors and Confirmations 1

» Automation Chase Mode
|Enable MIDI Chase |

= Display Edit Double Touch Select

# Dump Reguest Mode

&l

2 (<2l

=

4.3.1 Error/Status Reporting

Error, warning, and confirmation messages from the DMC1000 can be displayed
in the Status window in Project Manager. Users can choose whether or not
they want errors which occur in the DMC1000 and other status and
confirmation messages to be displayed on the Macintosh monitor.

a)

b)

Display Errors and Confirmations: When this is selected, the Status
window will pop open to display various warning messages,
indicate that errors have occurred, and confirm the execution of
commands.

No Error Reporting: No errors, warnings or confirmations will be
displayed on the Macintosh monitor.

4.3.2 Automation Chase Mode

When an automated mix is played from anywhere other than the beginning,
Project Manager needs to receive data from the DMC1000 in order to update its
parameter displays. Three Automation Chase Mode options are available:

a)

MIDI Chase Bulk Out: When this option is selected, Project
Manager will request an Edit Buffer bulk dump from the DMC1000
as soon as the DMC1000 has updated its state (ie. when playing
automation from the middle of an automated mix). This method
will function most efficiently when a mix contains a very large
amount of automation data. This is the default mode selected when
Project Manager is initialized.

Selecting this mode also causes the Automation Play -> MIDI Out
parameter to be set to ALL MIDI. This means that MIDI data for all
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parameters will be output by the DMC1000’s automation system
during playback (refer to 13.7.1 for further details).

b) Enable MIDI Chase: In this mode, the DMC1000 will output MIDI
data relating to all automation parameter changes at a very high
speed. If Automation Locate Mode: Quick is being used (refer to
12.1.1), it is only necessary to output automation data from after the
most recent Scene Memory recall. In the majority of typical mixing
situations, this mode will function very efficiently.

Selecting this mode also causes the Automation Play -> MIDI Out
parameter to be set to ALL MIDI.

c) No MIDI Chase: When this mode is selected, Project Manager’s
parameter displays will not be correctly updated during automation
playback. This puts less strain on the DMC1000’s CPU and may be
appropriate when very large automated mixes are being replayed -
particularly if the DMC Tools are not being used for display and
control of the DMC1000’s parameters.

Selecting this mode causes the Automation Play -> MIDI Out
parameter to be set to No MIDL.

Note: To make the most efficient use of the DMC1000’s automation system,
and to maximize Project Manager’'s performance, it is recommended that
automated mixes contain Scene Memory recalls at reasonably frequent
intervals. Automation Locate Mode: Quick should be used whenever possible.

M> 4.3.3 Display/Edit Double Touch Select
When this option is Enabled, a DMC1000 can be selected as the display console
by double-clicking on any of the SEL keys on the DMC1000’s control surface. If
Fader Touch Sense Select mode is On, a DMC1000 will also be selected as the
display console if a fader is tapped twice quickly.

M> 4.3.4 Dump Request Mode
This selection determines how bulk dump data (Scene Memories, etc.) will be
transferred from the DMC1000s to the Macintosh.

a) Sequential: Scene Memory data will be transferred from the
DMC1000s to the Macintosh in a sequential manner - one DMC1000
after another. This is the most reliable method to use, but may not
always be the fastest method.

b) Parallel: This mode allows data to be transferred from more than
one DMC1000 to the Macintosh simultaneously. Although data
transfer rates will potentially be improved using this mode,
reliability will depend on several factors (ie. number of DMC1000s in
the system, type of interface, processor speed of the computer, etc.).

4.4 Re-initialize Program
If any fault occurs which disrupts communications between the DMC1000 and
Project Manager, it can be useful to re-initialize the program. Select Re-Init
Program from the Project Manager menu. This will reset default parameters in
the DMC1000s and then request Setup data, Edit Buffer data (current state of
mixing console’s parameters), and Scene Memories 1-32 from each DMC1000.
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M> 4.5 Re-initialize Current DMC1000
The current display DMC1000 will be re-initialized when this is selected.

4.6 Abort

To immediately stop any data transfer process (such as transferring of Scene
Memory data), select Abort from the Project Manager menu.

4.7 Refreshing Displays and Updating State
The <escape> key on the Macintosh can be used to refresh and update Project
Manager in the following ways:

a) Pressing the <esc> key on the Macintosh keyboard once will refresh
all Project Manager displays based on the data contained in the
Mac’s own internal memory.

b) Pressing the <esc> key on the Macintosh keyboard twice quickly will
cause Project Manager to refresh its displays (and update its internal
state) by requesting the current Setup data and Edit Buffer data from
the display DMC1000. Under normal circumstances, this procedure
should not be necessary. However, if communications between
Project Manager and the DMC1000 were to be temporarily
interrupted, this procedure might be necessary.

M> In multiple-DMC1000 systems, Setup and Edit Buffer data from the display
DMC1000 will be transmitted to Project Manager when the <esc> key is
pressed twice quickly.



